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The following trademarks and registered trademarks are used throughout this manual: 

Microsoft, MS-DOS, Windows and Windows NT are registered trademarks of Microsoft Corporation in 
the USA and other countries.
i386, i486 and Pentium are trademarks of Intel Corporation.
Centronics is a registered trademark of Centronics Data Computer Corporation.
TrueType is a registered trademark of Apple Computer, Inc.

Universal Font Scaling Technology (UFST) and all typefaces have been licensed from Agfa Monotype.

Adobe     Acrobat     Reader    , Adobe Type Manager    and Adobe PostScript     3     software    1987-
2002 Adobe Systems Incorporated. All rights reserved.  Adobe, Acrobat, Acrobat Reader, Adobe Type 
Manager, PostScript, PostScript 3 and Reader are either registered  trademarks or trademarks of 
Adobe Systems Incorporated in the United States and/or other countries.

All other trademarks identified herein are the property of their respective owners.

Copyright    2000 - 2002 by Matsushita Graphic Communication Systems, Inc.
All rights reserved. Unauthorized copying and distribution is a violation of law.
Published in Japan.

The contents of these Operating Instructions are subject to change without notice.
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Before Use

Precautions

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to
part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference when the equipment is operated in a commercial environment. This equipment generates,
uses, and can radiate radio frequency energy and, if not installed and used in accordance with the
Operating Guide, may cause harmful interference to radio communications.

Operation of this equipment in a residential area is likely to cause harmful interference in which case the
user will be required to correct the interference at his/her own expense.

Any unauthorized changes or modifications to this equipment would void the users authority to operate this
device.

Warning: To assure continued compliance, use only a shielded interface cable when connecting the
machine’s parallel interface port to the host computer. Also, any changes or modifications not
expressly approved by the party responsible for compliance could void the user’s authority to
operate this equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1)
This device may not cause harmful interference, and (2) this device must accept any interference received,
including interference that may cause undesired operation.

• You need to read the software license agreement before setting up the Printer Driver.

• You need to read the following precautions which is described in the Machine’s Operating Instructions.
1. Installation
2. Ventilation
3. Handling
4. Toner and Paper
5. For your safety

For Users in the USA
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Printer Section

Installing the Printer Driver

Windows 98/Me/NT/2000/XP

1 Exit from all applications, then insert the Panasonic 
Printing System CD into the CD-ROM drive.

2 Select the desired language.

3 The setup message will appear.

Click the  button.

4 Click Printer Driver (PostScript3).

Next

Continued on the next page...
5
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6

Windows 98/Me/NT/2000/XP
5 Note for Windows 98/Me users:
If your computer does not have the LPR Port Monitor 
installed, please proceed to "Installing the LPR 
Monitor" on page 16 before continuing this 
installation.

Click Install Printer Driver (PostScript3).

6 The setup wizard will start.

Click the  button.

7 Read the license agreement, then click the 

 button.

8 Select Local Printer, then click the  

button.

Next

ACCEPT

Next
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Windows 98/Me/NT/2000/XP
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9 Select a printer port, normally LPT1 for local printers.

Click the  button.

(See Note 2 on page 9)

10 The Select Printer Model window appears.

Click the  button.

Note: The Window will appear with Generic 
PostScript Printer highlighted. Do not select 
this printer.

11 The Browse for Printer window appears.
Select the folder directory where the PPD files are 
stored. On the CD-ROM they are under 
D:\English\PS\Setup\Windows (where "D" is your 
CD-ROM driver). 

The printer models are also displayed.

Click the  button.

12 Choose your machine’s model and click the 

 button.

Next

Browse...

OK

Next

Continued on the next page...
7



Installing the Printer Driver
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Windows 98/Me/NT/2000/XP
13 Specify whether  the printer will be shared with other 
network users. Click Shared and enter a shared 
name, or click Not Shared.

Click the  button.

Note: This window does not appear in Windows 
98/Me. Sharing information is specified 
during Network Settings.

14 Printer Information window appears.
You can accept the default printer name shown or 
change it as you wish. 
Select Yes, if you want to use this printer as your 
default Windows printer. 
Select Yes, if you would like to print a test page.

Click the  button.

15 Verify the settings in the Setup Information window.

Click the  button.

16 The Printer Configuration window appears.
Select Yes, to configure your printer now.

Click the  button.

Next

Next

Install

Next
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Windows 98/Me/NT/2000/XP
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The Panasonic PostScript Printer Driver has been installed, and the Panasonic Printer icon has been added
to the Printer folder.

NOTE 1. When installing on Windows NT 4.0 and Windows 2000/XP, logon to the computer/network
using an account with administrator rights.

2 If the LPR Monitor is already installed on your PC, select  Create New Port in step 9. Then,
select Search the network printer to search for the machine(s) connected on your network.

17 Click the  button to return to the setup 

wizard.
Note: For printer properties, refer to "Configuring 

the Printer Driver Settings". 
(See pages 32 - 60)

18 Select Yes, if you want to view the ReadMe file.

Click the  button.

When the setup process is completed, a message is 
displayed prompting you to restart your computer.

Click the  button to restart your 

computer.

OK

Finish

Finish
9
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Mac OS 8.6/9.x

1 Exit from all applications, then insert the Panasonic 
Printing System CD into the CD-ROM drive.

2 Double-click the CD icon on the desktop.
English > PS > Setup > Mac > ps_88_E > US.sea
Please decompress US.sea with decompression
tool.
Double-click the AdobePS Installer icon to start the 
setup.

Note: Installation instructions
A ".hqx" ".sit" ".sea" file on a Macintosh, use 
StuffIt Deluxe or StuffIt Expander by Aladdin 
Systems (http://www.aladdinsys.com/) to 
access the file's contents. StuffIt Expander is 
available as a freeware product.

3 The setup message will be displayed.

Click the  button.

4 Read the license agreement, then click the 

 button.

5 Verify the installation location.

Click the  button.

Note: The printer driver must be installed on the 
disk with the active System software. If you 
want to change the location, click on the 
popup list for an installation location, choose 
[Select Folder] then choose or create a new 
folder.

Continue...

Accept

Install
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Mac OS 8.6/9.x
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6 A progress bar indicates that the printer driver is 
being installed.

7 When the setup process is completed, a message is 
displayed prompting you to restart your computer.

Click the  button to restart your 

computer.

After completing the installation of the AdobePS 
Printer Driver, you must copy the PostScript printer 
description (PPD) file into the System folder as 
follows:

8 Open the following folder within your Macintosh.
System > Extensions > Printer Descriptions

9 Open the Mac folder within the CD-ROM.
Select your printer model file, and drag it into your 
Printer Descriptions folder.

The AdobePS Printer Driver is installed, and the 
AdobePS icon is added to the Chooser.

Restart
11



Installing the Printer Driver
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Mac OS 8.6/9.x
10 Select the Apple Menu, then select Chooser.

11 Click the AdobePS icon as shown in the illustration.
Select your printer "Panasonic DP-xxxx" on the right.

Click the  button.

12 A PPD file for the desired printer must be present.
Select your machine’s model ("Panasonic_DP-

xxxx.PPD"), and click the  button.

Select the Panasonic_DP-3510_FS330.PPD file 
when your machine is a DP-3510, and is configured 
with a 2-Bin Finisher (DA-FS330).

13 Click the  button.

Create

Select

OK



Installing the Printer Driver

Mac OS 8.6/9.x
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14 Confirm and/or change the installable options 
settings for your printer.

Click the  button.

15 After the PPD file is copied, the driver creates a new 
desktop printer icon for your device.

OK
13



Installing the Printer Driver

14
A PostScript printer driver is already provided in Mac OS X. You need to install the PostScript printer
description (PPD) file into your system for printing.
To manage the Account Management with the Accounting Manager software, it is essential to setup the
Department Code with the PS Driver Security Utility before the Printer Driver is installed.

Mac OS X

1 Please copy the PostScript printer description (PPD) 
file into the Library folder as follows:
Open the following folder within your Macintosh.
Library > Printers > PPDs > Contents > 
Resources > en.lproj

2 Open the Mac folder within the CD-ROM.
Select your printer model file, and drag it into your 
en.lproj folder.

3 A list of available AppleTalk printers appears.
Select your machine’s model 
("Panasonic DP-xxxx").

4 Click on the Printer Model pull-down menu, and  
select "Panasonic_DP-xxxx.PPD".
Select Panasonic_DP-3510_FS330.PPD when your
machine is a DP-3510, and is configured with a 2-
Bin Finisher (DA-FS330).
The printer model selection window appears.
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5 Click the  button.

6 Your machine is added to the Printer List.

Add
15
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Installing the LPR (Line Printer Remote) Monitor

Windows 98/Me

1 Insert the Panasonic Printing System CD-ROM.

2 Select the desired language.

3 Click the  button.

4 Click Printer Driver (PostScript3).

5 Click Install LPR Monitor.

Next
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Windows 98/Me
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6 The Setup dialog box appears.

Click the  button.

7 The setup program copies the necessary files onto
the hard disk of your PC.
When the setup process is completed, a message
is displayed prompting you to restart your
computer.
It is recommended that you restart your computer
now so that the LPR Monitor can be started.

Click the  button.

If you have not installed the printer driver yet, please
proceed to "Installing the Printer Driver" on page 5.

8 After your computer has rebooted, click the Start 
button, select Settings, and then click Printers.

The Printers folder appears.

Right-click on the desired printer icon and select 
Properties from the pop-up menu.

Next

OK

Continued on the next page...
17



Installing the LPR (Line Printer Remote) Monitor
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Windows 98/Me
9 The printer properties dialog box appears.

The following step registers the LPR Port for network 
printing.

Before proceeding, ensure that the printer is 
installed, connected to the network, turned ON and is 
operating properly.

10 Select the Details tab and click the  

button.

Add Port...



Installing the LPR (Line Printer Remote) Monitor

Windows 98/Me
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NOTE 1 To print data via LAN, the LPR Monitor must be installed on your PC.

11 The Add Port dialog box appears. Click the Other 
radio button, select HLPRMON from "Click the type 
of port you want to add:" list and click  the 

 button.

12 The LPR Port Name dialog box appears.

Type the IP Address of the machine and "lp" as the 
queue name separated by a ":" (colon).

Ex: 10.74.229.105:lp

Click the  button. If an error occurs 

because the queue name had already been used for 
the same IP Address, select a different unique name 
such as "lpr".

13 The screen reverts to the Printer Properties.

Check that the "Print to the following port:" has been 
changed as entered in step 12, and click the Apply 

button first and then the  button.

The printer properties dialog box closes and you 
have now configured the printer as a network printer.

OK

OK

OK
19



Installing the LPR (Line Printer Remote) Service

20
Logon using an account with administrator rights.

Windows NT 4.0

1 Click the Start button, select Settings, and click 
Control Panel.

The Control Panel window appears.

Double-click on the Network applet.

The Network dialog box appears.

2 Click on the Services tab.

Verify whether the LPR Service is already installed.
(Indicated by Microsoft TCP/IP Printing shown in the 
Network Services list.)

If it is already installed, skip to Step 7. Otherwise 
continue installing the LPR Service.



Installing the LPR (Line Printer Remote) Service

Windows NT 4.0
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3 Click the  button to display the Select 
Network Service dialog box, and select Microsoft 
TCP/IP Printing.

Click the  button.

4 The Windows NT Setup dialog box appears.

Insert the Windows NT 4.0 CD-ROM, and type 
D:\i386 (where "D:" is your CD-ROM drive).

Click the  button.

5 After the files have been copied into the Hard Drive 
of your PC, the display returns to the Network dialog 
box. Confirm that the Microsoft TCP/IP Printing 
service has been added to Network Services list.

Click the  button.

Note: If the OK button does not change into a 
Close button, Remove and reinstall the 
Microsoft TCP/IP Printing service.

6 The Network Settings Change dialog box is 

displayed, click the  button to restart 

your computer now.

You have now completed the LPR Service 
installation.

Add...

OK

Continue

Close

Yes
21



Installing the LPR (Line Printer Remote) Service

22

Windows NT 4.0
7 After your computer has rebooted, log on with an 
account with Administrator Priviledges, click the Start 
button, select Settings, and then click Printers.

The Printers folder appears.

Right-click on the desired printer icon and select 
Properties from the pop-up menu.

8 The following step registers the LPR Port for network 
printing.

Before proceeding, ensure that the printer is 
installed, connected to the network, turned ON and is 
operating properly.

Select the Ports Tab and click the   

button.

9 The Printer Ports dialog box appears.

Select LPR Port and click the  

button.

Add Port...

New Port
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Windows NT 4.0
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10 The Add LPR compatible printer dialog box 
appears.

Enter the IP Address of the printer in the upper field, 
and "lp" for the print queue name in the lower field.

Click the  button.

(Please wait while the wizard verifies the IP Address 
and connectivity to the network.

11 The Printer Ports dialog box appears.

Click the  button.

12 Select the printer port and click the  

button.

The printer properties dialog box closes and you 
have now configured the printer as a network printer.

OK

Close

OK
23



Installing the LPR (Line Printer Remote) Port

24
Logon using an account with administrator rights.

Windows 2000/XP

1 Open the Printers folder.

Right-click on the desired printer icon and select 
Properties from the pop-up menu.

The printer properties dialog box appears.

2 Select the Ports Tab and click the   

button.

3 Select Standard TCP/IP Port and click the 

 button.

Add Port...

New Port...
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Windows 2000/XP
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4 Click the  button.

5 Enter the IP Address and the Port Name and click 

the  button.

Note: The Port Name is automatically entered by 
Windows 2000/XP. You may need to 
change it as required.

6 Select Custom and click the  button.

Next

Next

Settings...
25



Installing the LPR (Line Printer Remote) Port

26

Windows 2000/XP
7 1. In the Protocol section, select LPR.
2. In the LPR Settings section, enter the Queue 

Name (e.g. LPR1) and select the LPR Byte 
Counting Enabled.

3. Click the  button.

8 Click the  button.

9 Click the  button.

OK

Next

Finish
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Windows 2000/XP

Pr
in

te
r S

ec
tio

n

10 Click the  button.

11 Click the  button.

Click the  button.

The printer properties dialog box closes and you 
have now configured the printer as a network printer.

Close

Apply

OK
27
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Installing the PS Driver Security Utility

If you wish to use the MailBox and Secure MailBox functions, it is essential that you setup the Utility settings
first.
To control the Charge Management with the Accounting Management application, it is essential that you
setup the Utility settings first.

Windows 98/Me/NT/2000/XP

1 Exit from all applications, then insert the Panasonic 
Printing System CD into the CD-ROM drive.

2 Select the desired language.

3 The setup message will display.

Click the  button.

4 Click Printer Driver (PostScript3).

Next
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Windows 98/Me/NT/2000/XP
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5 Select Install PS Driver Security Utility.

6 Click the  button.

7 Click the  button if you want to place a

shortcut to PS Security Utility on your desktop.

8 The required files are copied.

Next

Yes
29



Installing the PS Driver Security Utility

30

Windows 98/Me/NT/2000/XP
The PS Driver Security Utility folder has been added to the Program menu, and the installation has now
completed.

9 Click the  button.Finish
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In order to utilize Department Codes,  Mailboxes or Secure Mailboxes, the appropriate information must be
input prior to installing the printer driver.
Use the PS Driver Security Utility to change the setting before adding the printer.
If you have already added the printer, delete it, change the setting using the PS Driver Security Utility, then
add the printer.

Mac OS 8.6/9.x/X

1 Exit from all applications, then insert the Panasonic 
Printing System CD into the CD-ROM drive.
Double-click the CD icon on the desktop.
For OS 8.6/9.x: Browse to folder English > PS >       

Setup > Mac > Tools >
For OS X          : Browse to folder English > PS >        

Setup > Mac > Tools > OSX_only
Copy PsSecure.sit to your hard disk.

Note: If PsSecure.sit does not automatically 
decompress, install a suitable 
decompression utility.

2 Double-click the PS Driver Security Utility icon to 
start.

Note: Installation instructions
A ".hqx" ".sit" ".sea" file on a Macintosh, use 
StuffIt Deluxe or StuffIt Expander by Aladdin 
Systems (http://www.aladdinsys.com/) to 
access the file's contents. StuffIt Expander 
is available as a freeware product.
31
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Configuring the Printer Driver Settings

To change the printer settings, open the printer properties by performing the following steps.

Windows 98/Me

1 Click the Start button, select Settings, and then click 
Printers.

2 Right-click the desired printer icon in the Printers folder,
and select Properties in the popup menu.

The printer properties dialog box appears.
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General Tab

1. Comment
Enter comments to the properties, if any.

If another user sets up this printer on his or her computer when sharing the printer, the comment specified
here will also appear on that computer. However, the comment displayed for an existing user will remain
unchanged even if the comment is modified later.

2. Separator page
This feature is not available on your machine.

3.  button
Prints a test page. This allows the user to verify if the printer is installed properly.

Print Test Page
33



Configuring the Printer Driver Settings
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Windows 98/Me

Details Tab

1. Print to the following port
Displays either the port where the printer is connected or the path to the network printer.

To change the printing destination, either select the printing destination port from the list or enter the
network path here.

2.  /  button
Adds/deletes new port or new network path.

3. Print using the following driver
Displays the type of the printer driver. Specify the printer being used or a printer model which can be
emulated with the printer being used.

4.  button
Updates or modifies the printer driver.

5.  /  button
Assigns a local port to the network connected printer or cancels a local port assigned to the network
printer.

6. Timeout settings - Not selected
Specify the amount of time (in seconds) allowed to elapse before the printer comes online. If the printer is
not online within this duration, an error message will be displayed.

Add Port... Delete Port...

New Driver...

Capture Printer Port... End Capture...
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7. Timeout settings - Transmission retry
Specify the amount of time (in seconds) allowed to elapse before the printer is ready for printing. If the
printer is not ready for printing within this duration, an error message will be displayed.

Increase this value if a timeout error occurs when printing a large document.

8.  button
Specify the method of sending (spool) documents from the program to the printer.

• Spool Data Format
Select spool data type (RAW format). Specifying RAW format results in a longer time elapsing before an
application becomes operational after printing from it.

• Enable bidirectional support
Be sure to check the check box for "Enable bidirectional support" when installing the status monitor.
Otherwise, status information reception may not function properly.

9.  button
Modifies printer port settings.

Spool Settings...

Port Settings...
35
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Windows 98/Me

Sharing Tab (See Note 1)

1. Not Shared/Shared As
Select whether to display or share this printer with other computers.

2. Share Name
Specify the name of the shared printer. The displayed name can be used as it is or a new name may be
entered. The name specified here will be displayed when other users view information about the printer
on the network.

3. Comment
You can enter comments regarding a shared printer (such as the type of printer and the location where it
is installed). When other users view information about the printer on the network, the comment specified
here will be displayed.

4. Password
Specify a password required when other users will connect to this printer. 
Leave the box blank in order not to use any password.

NOTE 1. Sharing Tab in property dialog box is not displayed unless printer sharing has been specified.
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Paper Tab

1. Paper size
Select a document size.

2. Orientation
Select the print orientation (Portrait/Landscape).

3. Paper control
Controls printer outputs and groups pages. 
Select Collate if you wish each set of multiple copies collated when you print them. Otherwise, each page
is printed in individual groups. 
The Duplex menu specifies whether and how the printer should print the document on both sides of the
paper.

4. Paper source
Specify where the paper you want to use is located in the device.  If you choose Auto Select Tray, the
printer driver will automatically select an appropriate tray according to the Paper Size selected.

5. Output bin
Specifies which output bin to use for your printed document. Some printer models have more than one
output bin you can use for sorting your documents.

6. Paper type
Specifies the type of paper medium to use, such as plain or thick.

7.  button
Displays the Margins dialog box. Click this button to view the area of the page that is unavailable for
printing.

Margins...
37



Configuring the Printer Driver Settings

38

Windows 98/Me

8.  button

Displays version and copyright information for this printer driver.

9.  button
Displays the help window for this printer driver.

10.  button
Sets the values of all options in the current dialog box to the default values specified in the PPD file.

About...

Help

Restore Defaults
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Graphics Tab

1. Resolution
Select the resolution you want for printing (300dpi/600dpi/1200dpi Enhanced).

2. Special
Prints a negative image and/or mirror image of your document. Click these options to view an example.

3. Paper handling
Specify the layout pattern for printing multiple documents on a single sheet of paper and whether page
borders are used.  Select these options to view an example.

4. Scaling
Specify an enlargement or reduction percentage when printing documents.  If enlargement/reduction can
be set within the application, indicate 100% here and specify the enlargement/reduction percentage in
the Print dialog box of the application.
Note: 
If the Resolution Tab is set to 600 dpi or 1200 dpi, the zoom ratio is changed depending on the paper
size.
Ledger : 25 - 400%
Legal : 25 - 400%
A3 : 25 - 400%
B4 : 25 - 400%
Others : 25 - 400%

5. Convert gray text/graphics to PostScript gray
This feature is not available on your machine.

6.  button
Displays the help window for this printer driver.

7.  button
Sets the values of all options in the current dialog box to the default values specified in the PPD file.

Help

Restore Defaults
39
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Windows 98/Me

Fonts Tab

1. Substitute printer fonts for TrueType fonts when applicable
Tells the driver to determine which PostScript fonts to substitute for TrueType fonts.
Instead of sending all TrueType fonts to your printer, this option substitutes a PostScript printer font for
the common TrueType fonts used in your document.

By default, common TrueType fonts are substituted with their PostScript look-alikes when printing, but
those with no PostScript look-alike font are sent to the printer in the format specified in the Send
TrueType Fonts As box of the Send Fonts As dialog box.

2. Do not use printer fonts
Disables using printer-resident fonts. Use this advanced option when you expect to send the PostScript
output to different printer models.

3. Add Euro Currency Symbol to PostScript Fonts
Adds the European currency symbol to most PostScript fonts.

4.  button
Updates the list of PostScript fonts that have been downloaded to the printer so that the driver prints them
correctly.

5.  button
Displays the Send Fonts As dialog box. Click this button to specify how to send TrueType or PostScript
fonts.

6.  button
Displays the help window for this printer driver.

7.  button
Sets the values of all options in the current dialog box to the default values specified in the PPD file.

Update Soft Fonts

Send Fonts As...

Help

Restore Defaults
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Device Options Tab (See Note 1)

1. Available printer memory
Specifies the amount of available printer memory. The driver uses this information when performing
printing tasks, such as sending fonts from the computer to the printer.

2. Available font cache
Displays the amount of font cache memory now available to Type 32 fonts (bitmap font format).  The
Driver automatically adjusts the font cache size according to the installed memory option selected in the
Installable options box.

3. Printer features
Specifies the following printer settings:
• Sort

Select whether to Stack or Sort when printing multiple copies.
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Windows 98/Me

• Staple

Select the staple position. Available if the optional Finisher (DA-FS600, FS605, FS330 or FS355) is
installed.

• Punch
Select the punch position. Available if the optional Punch Unit is installed.

• Secure
Select the Mailbox or Secure Mailbox if storing the print data into the mailbox of the machine. Available
if the optional Hard Disk Drive Unit (DA-HD60) is installed.
Note: The PS Driver Security Utility must be installed in order to use the user ID password.

• Print Blank Pages
Select whether the blank pages are printed or not.

Portrait (Top Left / Left / Top Right / Right)

Landscape (Top Left / Top Right / Top)

Portrait (Saddle Stitch)

Landscape (Saddle Stitch)
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• Tray Switching
Allow the paper to be fed continuously if the same size of paper is loaded in another paper tray (Auto
Tray Switching). If not selected, the machine will stop if paper runs out in the chosen paper tray.

4. Installable options
Specifies the following printer settings:

• Number of Paper Trays
Select the number of available paper trays for the printer if an optional system console is installed.

• Large Capacity Paper Tray (LCT)
Select if a Large Capacity Paper Tray is installed.

• Finisher
Select the type of Finisher if a Finisher is installed.

• Punch Unit
Select if a Punch Unit is installed.

• Hard Disk Drive
Select if the HDD Unit is installed.

• Memory
Select the memory (Standard or additional).
(Only available if the optional HDD unit (DA-HD60) is installed)

5.  button
Displays the help window for this printer driver.

6.  button
Sets the values of all options in the current dialog box to the default values specified in the PPD file.

NOTE 1 Device Option Tab specifies device-specific settings and settings of optional devices.

Help

Restore Defaults
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PostScript Tab

1. PostScript output format
Specifies the format for the PostScript files. In general, use PostScript (Optimize For Speed) for printing a
document.

2. PostScript header
Specifies whether to send header information to the printer each time you print a document; this is an
advanced feature to use only if you have experience working with headers.

3. Print PostScript error information
Specifies whether to send a special PostScript error handler with every document that you print.

4. PostScript timeout value - Job timeout
Specifies the maximum number of seconds that the print job can take to get from the computer to the
printer before the job is canceled. 
A value of zero means that the job is never canceled. If your printer is shared, do not specify a value of
zero.

5. PostScript timeout value - Wait timeout
Specifies the maximum number of seconds that the printer will wait for the computer to send data before
canceling the job.
A value of zero means that the job is never canceled. If your printer is shared, do not specify a value of
zero.

6.  button
Displays the Advanced PostScript Options dialog box. Click this button to view and change advanced
PostScript settings. Only use this option if you are an advanced user with experience working with
PostScript.

7.  button
Displays the help window for this printer driver.

8.  button
Sets the values of all options in the current dialog box to the default values specified in the PPD file.

Advanced...

Help

Restore Defaults
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Watermarks Tab

1. Select a watermark
Lists and displays the available watermark definitions. You can click an entry in the list to select it for
editing or deleting.

The  button displays the New Watermark dialog box, which lets you add a new watermark to the
Select a Watermark list.

2. Print watermark
Specifies the watermark form and style.

3.  button
Displays the help window for this printer driver.

New

Help
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General Tab

1. Comment
Enter comments to the properties, if any.

If another user sets up this printer on his or her computer when sharing the printer, the comment specified
here will also appear on that computer. However, the comment displayed for an existing user will remain
unchanged even if the comment is modified later.

2. Location
Specifies the printer location.

3. Driver
Displays the printer driver type. Specify the printer being used or a printer model that can be emulated
with the printer being used.

Click  button updates or modifies the printer driver.

4.  button
This feature is not available on your machine.

5.  button
Specify the processor to be used for printing (Print Processor) and the data type (Default Data type).

The processor and data type affect the manner in which the printer functions in Windows NT. Normally
they do not need to be modified. However, modification might be necessary when the printer is used with
a special application.

6.  button
Prints a test page. This allows the user to verify if the printer is installed properly.

NOTE 1. In Windows NT 4.0, setting the properties depends on the logon account. This section
describes properties to be specified by the administrator (system manager).
See "Printing from Windows Application" for details on user properties.  (See page 85)

Windows NT 4.0 (Administrator Settings)

New Driver...

Separator Page...

Print Processor...

Print Test Page
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Ports Tab

1. Print to the following port(s)
Displays a list of available ports for printing (Port), their status (Description) and printers that are
connected to these ports (Printer).

2.  /  button
Adds/deletes a new port or a new network path.

3.  button
Configures the selected port.  In case of a parallel port, Transmission Retry should be specified.

4. Enable bidirectional support
On a printer, this setting enables reception of configuration data and status data from computer.

5. Enable printer pooling
Printer pooling allows outputting data from one logical printer to two or more printers. With printer pooling
enabled, a transmitted printing job is output to the first printer that is ready for printing.

Add Port... Delete Port

Configure Port...
47



Configuring the Printer Driver Settings

48

Windows NT 4.0 (Administrator Settings)

Scheduling Tab

1. Available
Schedules when the printer is available for operation. Specify operating hours when From-To is selected.

2. Priority
Sets printing priority. The slider allows the priority to be adjusted from 1 through 99.

3. Spool print documents... / Print directly to the printer
Specify how documents should be sent from an application to the printer.

4. Hold mismatched documents
The spooler compares document settings against printer settings and holds printing of a document if its
settings (Paper Size, Orientation, and so on) do not match the printer settings.

5. Print spooled documents first
Always prints spooled documents first regardless of printing priority.

6. Keep documents after they have printed
Holds documents in the print queue even after they have been printed. These documents can be printed
again directly from the queue regardless of the state the application is in.
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Sharing Tab

1. Not Shared/Shared
Select whether to display or share this printer with other computers.

2. Share Name
Specify the name of the shared printer. The displayed name can be used as it is or a new name may be
entered. The name specified here will be displayed when other users view information about the printer
on the network.

3. Alternate Drivers
Allows other operating systems' printer drivers to be loaded.  When users of these operating systems
connect to the printer, the printer driver is automatically loaded.

NOTE 1. When sharing a printer on the network, the print driver needs to be installed on the print server
only, other computers will automatically copy and use that driver.
For this reason, the print server must be ready with printer drivers for all the operating systems
of all the computers that will be sharing the printer.
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Windows NT 4.0 (Administrator Settings)

Security Tab

1.  button
Set printer access privileges.

2.  button
Displays the users who have used this printer and how they used it.

3.  button
Set the ownership of the printer.

NOTE 1. In order to utilize these features, first you need to select Audit... from User Manager's
Policies and enable File and Object Access in the Audit Policy dialog  box.

Permissions

Auditing

Ownership
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Device Settings Tab

Specifies the following printer settings and options:

• Form To Tray Assignment
Specifies the paper size of each available tray.

• Font Substitutuion Table
Specifies which PostScript fonts to substitute for TrueType fonts. Instead of sending all TrueType fonts to
your printer, this option substitutes a PostScript printer font for the common TrueType fonts used in your
document.

• Available PostScript Memory
Specifies the amount of available printer memory. The driver uses this information when performing
printing tasks, such as sending fonts from the computer to the printer.

• Output Protocol
Specifies the data format to the printer. Only use this option if you are an advanced user with experience
working with PostScript.

• Send CTRL-D Before/After Each Job
Sends a CTRL+D to notify the printer that the current job has finished printing and to reset the printer. Only
use this option if you are an advanced user with experience working with PostScript.

• Convert Gray Text/Grapgics to PostScript Gray
This feature is not available on your machine.

• Add Euro Currency Symbol to PostScript Fonts
Adds the European currency symbol to most PostScript fonts.

• Job timeout
Specifies the maximum number of seconds that the print job can take to get from the computer to the
paper before the job is canceled.
A value of zero means that the job is never canceled. If your printer is shared, do not specify a value of
zero.
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• Wait timeout
Specifies the maximum number of seconds that the printer will wait for the computer to send data before
canceling the job.
A value of zero means that the job is never canceled. If your printer is shared, do not specify a value of
zero.

• Minimum Font Size to Download as Outline
Specifies the minimum font size to download as Outline. Increasing this value can speed up printing.

• Maximum Font Size to Download as Bitmap
Specifies the maximum font size to download as Bitmap. Decreasing this value can speed up printing.

Installable Options

• Number of Paper Trays
Select the number of available paper trays for the printer if an optional system console is installed.

• Large Capacity Paper Tray (LCT)
Select if a Large Capacity Paper Tray is installed.

• Finisher
Select the type of Finisher if a Finisher is installed.

• Punch Unit
Select if a Punch Unit is installed.

• Hard Disk Drive
Select if the HDD Unit is installed.

• Memory
Select the memory (Standard or additional).
(Only available if the optional HDD unit (DA-HD60) is installed)
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General Tab

1. Printer Name
Name of the printer specified upon installation is displayed.

2. Location
Specifies the printer location.

3. Comment
Enter comments to the properties, if any.

If another user sets up this printer on his or her computer when sharing the printer, the comment specified
here will also appear on that computer. However, the comment displayed for an existing user will remain
unchanged even if the comment is modified later.

4. Features
Functions and settings of the printer are displayed.

5.  button
Changes properties (print settings) specifiable for each user.
Refer to "Printing from Windows Applications" for detailed settings.  (See page 85)

6.  button
Prints a test page. This allows the user to verify if the printer is installed properly.

NOTE 1. In Windows 2000/XP, setting the properties depends on the logon account. This section
describes properties to be specified by the administrator (system manager). 
See "Printing from Windows Applications" for details on user properties. (See page 85)

Windows 2000/XP (Administrator Settings)

Printing Preferences...

Print Test Page
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Sharing Tab

1. Not shared/Shared as
Select whether to display or share this printer with other computers.

For sharing a printer, specify the share name of a printer to be shared. A name specified here appears
when other users view the printer information on a network.

2.  button
Allows other operating systems' printer drivers to be loaded.  When users of these operating systems
connect to the printer, the printer driver is automatically loaded.

NOTE 1. When sharing a printer on the network, the print driver needs to be installed on the print server
only, other computers will automatically copy and use that driver.
For this reason, the print server must be ready with printer drivers for all the operating systems
of all the computers that will be sharing the printer.

Additional Drivers...
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Ports Tab

1. Print to the following port(s)
Displays a list of available ports for printing (Port), their status (Description) and printers that are
connected to these ports (Printer).

2.  /  button
Adds/deletes a new port or a new network path.

3.  button
Configures the selected port.  In case of a parallel port, Transmission Retry should be specified.

4. Enable bidirectional support
Be sure to check the check box for "Enable bidirectional support" when installing the status monitor.
Otherwise, status information reception may not function property.

5. Enable printer pooling
Printer pooling allows outputting data from one logical printer to two or more printers. With printer pooling
enabled, a transmitted printing job is output to the first printer that is ready for printing.

Add Port... Delete Port

Configure Port...
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Advanced Tab

1. Always available/Available from
Schedules when the printer is available for operation. Specify operating hours when From-To is selected.

2. Priority
Sets printing priority. The slider allows the priority to be adjusted from 1 through 99.

3. Driver
Displays the printer driver type. Specify the printer being used or a printer model that can be emulated
with the printer being used.

4.  button
Updates or modifies the printer driver.

5. Spool print documents... / Print directly to the printer
Specify how documents should be sent from an application to the printer.

6. Hold mismatched documents
The spooler compares document settings against printer settings and holds printing of a document if its
settings (Paper Size, Orientation, and so on) do not match the printer settings.

7. Print spooled documents first
Always prints spooled documents first regardless of printing priority.

8. Keep printed documents
Holds documents in the print queue even after they have been printed. These documents can be printed
again directly from the queue regardless of the state the application is in.

New Driver...
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9. Enable advanced printing features
Enables advanced printing features. Optional features of the printer (page ordering, booklet printing,
numbering on sheets) are enabled. These features can be disabled if a problem occurs due to
incompatibility. Disabling the features may also disable the printing options.

10.  button
Specifies standard (default) values for the properties (print settings) specifiable for each user. If a local
printer is shared, the settings here are used as printing defaults for other users.
Refer to "Printing from Windows Applications" for detailed settings.  (See page 85)

11.  button
Specify the processor to be used for printing (Print Processor) and the data type (Default Data type). The
processor and data type affect the manner in which the printer functions in Windows 2000/XP. Normally
they do not need to be modified. However, modification might be necessary when the printer is used with
a special application.

12.  button
This feature is not available on your machine.

Printing Defaults...

Print Processor...

Separator Page...
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Security Tab

Displays a list of users and groups to whom printer access is assigned to. A list of standard permissions for
each group or user is displayed. Check the checkboxes for permitting or prohibiting access. Gray checkbox
indicates the permission inheritance.

1.  /  button
Add or delete a user or group from the list.

2.  button
Specify access to a printer, audit, and owner.

NOTE 1. Windows 2000 provides the capability of managing access to various objects (e.g. printers) by
users.

2. Refer to the Windows 2000 documentation for details on access permission, audit, and owner.
3. The Security Tab is not shown in Windows XP.

Add... Remove

Advanced...
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Device Settings Tab

Specifies the following printer settings and options:

• Form To Tray Assignment
Specifies the paper size of each available tray.

• Font Substitutuion Table
Specifies which PostScript fonts to substitute for TrueType fonts. Instead of sending all TrueType fonts to
your printer, this option substitutes a PostScript printer font for the common TrueType fonts used in your
document.

• Available PostScript Memory
Specifies the amount of available printer memory. The driver uses this information when performing
printing tasks, such as sending fonts from the computer to the printer.

• Output Protocol
Specifies the data format to the printer. Only use this option if you are an advanced user with experience
working with PostScript.

• Send CTRL-D Before/After Each Job
Sends a CTRL+D to notify the printer that the current job has finished printing and to reset the printer. Only
use this option if you are an advanced user with experience working with PostScript.

• Convert Gray Text/Grapgics to PostScript Gray
This feature is not available on your machine.

• Add Euro Currency Symbol to PostScript Fonts
Adds the European currency symbol to most PostScript fonts.

• Job timeout
Specifies the maximum number of seconds that the print job can take to get from the computer to the
paper before the job is canceled.
A value of zero means that the job is never canceled. If your printer is shared, do not specify a value of
zero.
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• Wait timeout
Specifies the maximum number of seconds that the printer will wait for the computer to send data before
canceling the job.
A value of zero means that the job is never canceled. If your printer is shared, do not specify a value of
zero.

• Minimum Font Size to Download as Outline
Specifies the minimum font size to download as Outline. Increasing this value can speed up printing.

• Maximum Font Size to Download as Bitmap
Specifies the maximum font size to download as Bitmap. Decreasing this value can speed up printing.

Installable Options

• Number of Paper Trays
Select the number of available paper trays for the printer if an optional system console is installed.

• Large Capacity Paper Tray (LCT)
Select if a Large Capacity Paper Tray is installed.

• Finisher
Select the type of Finisher if a Finisher is installed.

• Punch Unit
Select if a Punch Unit is installed.

• Hard Disk Drive
Select if the HDD Unit is installed.

• Memory
Select the memory (Standard or additional).
(Only available if the optional HDD unit (DA-HD60) is installed)



Pr
in

te
r S

ec
tio

n

Configuring the Printer Driver Settings (Macintosh)

To change the printer settings, open the printer properties by performing the following steps.

In print window, you will see a number of titles in the pop-up menu. The appropriate operating system shows
different titles in the window.

Mac OS 8.6/9.x:
Click the  button to save the current settings for the default values.

Mac OS X:
Select the  menu to save the current settings for the default values.

1 Select the File menu > Print.

2 Select the Panasonic printer.

Save Setting

Save Custom Setting
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General menu

1. Copies
Specify the number of copies to be printed.

2. Pages
Specify the range of printing pages.

3. Paper Source
Specify where the paper you want to use is located in the device.  If you choose Auto Select, the printer
driver will automatically select an appropriate tray according to the Paper Size selected.

Mac OS 8.6/9.x
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Background Printing menu

1. Print in
Select Foreground or Background printing.
Foreground printing ties-up your Macintosh while it prints the job. Printing is completed more quickly, and
the document takes less disk space when preparing for printing.
The Background selection causes your Macintosh to write your job to the hard disk before printing it. This
frees-up the computer so you can work while the job is printing, but it takes longer overall.

2. Print Time
Schedules when the printer outputs current documents.
You can specify operating hours when From-To is selected, or holds documents in the print queue.
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Mac OS 8.6/9.x

Cover Page menu

NOTE:
This feature is not available on your machine.
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Color Matching menu

NOTE:
This feature is not available on your machine.
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Layout menu

1. Pages per sheet
Specify the number for printing multiple documents on a single sheet of paper.  Select this option to view
an example.

2. Layout direction
Specify the layout direction for printing multiple documents on a single sheet of paper.  Select this option
to view an example.

3. Border
Specify whether page borders are used when printing multiple documents on a single sheet of paper.

4. Print on Both Sides / Binding
Specify whether and how the printer should print the document on both sides of the paper.
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Error Handling menu

1. If there is a PostScript error
Specifies how to send PostScript error information with every document that you print.

2. If the cassette is out of paper
Specify what will happen if paper runs out in the chosen paper tray.
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PostScript Settings menu

1. Format
Specifies the format for the PostScript files. In general, use PostScript job for printing a document.

2. PostScript Level
Specifies the level for the PostScript.

3. Data Format
Specifies the data format to the printer. Only use this option if you are an advanced user with experience
working with PostScript.

4. Font Inclusion
Specifies the font inclusion for the PostScript print.
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Output menu

1. Collation
Specify whether if you wish each set of multiple copies collated when you print them. Otherwise, each
page is printed in individual groups.

2. Finisher Bin
Specifies which output bin to use for your printed document. Some printer models have more than one
output bin you can use for sorting your documents.

3. Sort
Select whether to Stack or Sort when printing multiple copies.

4. Staple
Select the staple position. Available if the optional Finisher (DA-FS600, FS605, FS330 or FS355) is
installed.

5. Punch
Select the punch position. Available if the optional Punch Unit is installed.
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Quality menu

1. Media Type
Select the paper type.

2. Resolution
Select the resolution you want for printing (300dpi/600dpi/1200dpi Enhanced).
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Printer Specific Options menu

1. Secure
Select the Mailbox or Secure Mailbox if storing the print data into the mailbox of the machine. Available if
the optional Hard Disk Drive Unit (DA-HD60) is installed.
Note: The PS Driver Security Utility must be installed in order to use the user ID password.

2. Print Blank Pages
Select whether the blank pages are printed or not.
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With Macintosh OS X, such functions as Staple, Punch and Secure cannot be used because Print Center >
Printers > Configure Printer... is grayed out and Device Options cannot be selected.

For details, refer to Support on Apple’s website (http://www.info.apple.com/).

Mac OS X
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Copies & Pages menu

1. Copies
Specify the number of copies to be printed.
Select "Collated" if you wish each set of multiple copies collated when you print them.  Otherwise, each
page is printed in individual groups.

2. Pages
Specify the range of printing pages.
73



Configuring the Printer Driver Settings (Macintosh)

74

Mac OS X

Layout menu

1. Pages per sheet
Specify the number for printing multiple documents on a single sheet of paper.  Select this option to view
an example.

2. Layout direction
Specify the layout direction for printing multiple documents on a single sheet of paper.  Select this option
to view an example.

3. Border
Specify whether page borders are used when printing multiple documents on a single sheet of paper.
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Duplex menu

Print on Both Sides / Binding
Specify whether and how the printer should print the document on both sides of the paper.
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Output Options menu

Save as File / Format
Select to save your document as a file. You can specify the file format. 
The document will not be send to the printer.
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Paper Feed menu

All pages from / First pages from
Specify where the paper you want to use is located in the device.  If you choose Auto Select, the printer
driver will automatically select an appropriate tray according to the Paper Size selected.
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Error Handling menu

1. PostScript Errors
Specifies how to send PostScript error information with every document that you print.

2. Tray Switching
Specify what will happen if paper runs out in the chosen paper tray.
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Printer Features menu
Output tab:

1. Finisher Bin
Specifies which output bin to use for your printed document. Some printer models have more than one
output bin you can use for sorting your documents.

2. Sort
Select whether to Stack or Sort when printing multiple copies.

3. Staple
Select the staple position. Available if the optional Finisher (DA-FS600, FS605, FS330 or FS355) is
installed.

4. Punch
Select the punch position. Available if the optional Punch Unit is installed.
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Mac OS X

Quality tab:

1. Media Type
Select the paper type.

2. Resolution
Select the resolution you want for printing (300dpi/600dpi/1200dpi Enhanced).
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Miscellaneous tab:

1. Secure
Select the Mailbox or Secure Mailbox if storing the print data into the mailbox of the machine. Available if
the optional Hard Disk Drive Unit (DA-HD60) is installed.
Note: The PS Driver Security Utility must be installed in order to use the user ID password.

2. Print Blank Pages
Select whether the blank pages are printed or not.
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Mac OS X

Summary menu

Functions and settings of the printer are displayed.
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Configuring the PS Driver Security Utility

• User ID
Input the user ID (8 numbers maximum) to be used for MailBox or Secure MailBox.

• Password
Input the password (4 numbers maximum) to be used for Secure MailBox.

• Department Code
Input the department code (8 numbers maximum) to be used by the accounting manager.

• Local Host IP Address
Displays the IP address where notification of completion is to be sent.

• OK
Stores the input values and closes the utility.

• Cancel
Cancels the input values and closes the utility.

NOTE 1 The department code must be input for customers for which charge management is to be
performed using an accounting management application.

Windows 98/Me/NT/2000/XP
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If you are using Mac OS X, use the PS Driver Security Utility to change the setting before adding the printer.
If you have already added the printer, delete it, change the setting using the PS Driver Security Utility, then
add the printer.

• User ID
Input the user ID (8 numbers maximum) to be used for MailBox or Secure MailBox.

• Password
Input the password (4 numbers maximum) to be used for Secure MailBox.

• Department Code
Input the department code (8 numbers maximum) to be used by the accounting manager.

• OK
Stores the input values and closes the utility.

• Cancel
Cancels the input values and closes the utility.

NOTE 1 The department code must be input for customers for which charge management is to be
performed using an accounting management application.

Mac OS 8.6/9.x/X
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Printing from Windows Applications

If the printer driver is installed properly and a printer is selected as the default printer in the printer setup,
printing can be accomplished from any Windows application with simple operations.

Printing from most Windows applications, select File menu > Print, the Print dialog box appears.

• Printing
After selecting the page range to be printed and the number of copies, click the  button to start
printing.

While documents are being printed, a printer icon appears in the System Tray near the clock on the bottom
right hand corner of the screen. The icon disappears when printing is completed.

You may double-click on the printer indicator in the System Tray to open and verify the details of the print
queue in the spooler.

• User Settings
In the Print dialog box, click the  button (top-right corner), the printer properties window
appears.
The appropriate operating system shows different properties in the window.

NOTE 1. Follow the steps below to set a default printer:
1) Click the Start button and select Printers in the Settings menu or Printers Fases for win XP.
2) Select the printer icon in the window and select [Set As Default] in popup menu by right-

clicking it. Then the check mark is displayed.

OK

Properties...
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Paper Tab

Refer to "Configuring the Printer Driver Settings" for details on settings  (See page 37).

Windows 98/Me
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Page Setup Tab

1. Paper Size
Select a document size.

2. Paper source
Specify where the paper you want to use is located in the device.  If you choose Automatically Select,
the printer driver will automatically select an appropriate tray according to the Paper Size selected.

3. Copy Count
Specify the number of copies to be printed.

4. Collate Copies
Select if you wish each set of multiple copies collated when you print them. Otherwise, each page is
printed in individual groups.

5. Orientation
Select the print orientation (Portrait/Landscape/Rotated).
(The Rotated output is the same as that of Landscape.)

6. Print on Both Sides
Specify whether and how the printer should print the document on both sides of the paper.

7. Color Appearance
This feature is not available on your machine.

Windows NT 4.0 (User Settings)
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Windows NT 4.0 (User Settings)

Advanced Tab

Specifies advanced printer settings and options. Refer to "Windows NT 4.0 (Administrator Settings)"  (See
page 51).
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Layout Tab

1. Orientation
Select the print orientation (Portrait/Landscape/Rotated).
(The Rotated output is the same as that of Landscape.)

2. Print on Both Sides
Specify whether and how the printer should print the document on both sides of the paper.

3. Page Order
Specify page order when printing multiple pages.

4. Pages Per Sheet
Specify the number for printing multiple documents on a single sheet of paper.

5.  button
Specifies advanced printer settings and options.  Refer to "Windows 2000/XP (Administrator Settings)"
(See page 59).

Windows 2000/XP (User Settings)

Advanced...
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Windows 2000/XP (User Settings)

Paper/Quality Tab

1. Paper source
Specify where the paper you want to use is located in the device.  If you choose Automatically Select,
the printer driver will automatically select an appropriate tray according to the Paper Size selected.

2. Media
Select the paper type.

3.  button
Specifies advanced printer settings and options.  Refer to "Windows 2000/XP (Administrator Settings)"
(See page 59).

Advanced...
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Printing from Macintosh Applications

If the printer driver is installed properly, printing can be accomplished from any Macintosh application with
simple operations.

Printing from most Macintosh applications, select File menu > Print, the Print dialog box appears.

• Printing
After selecting the page range to be printed and the number of copies, click the  button to start
printing.

• Printer Settings
In print window, you will see a number of titles in the pop-up menu.  Refer to "Configuring the Printer Driver
Settings" for printer settings  (See page 61).

Print
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Printing on Network

For sharing a printer by connecting two computers via a crossover cable or using a hub, a connection
among computers must be established.

Establishing a connection among computers can be verified by displaying the connected computers in
Network Neighborhood on the desktop.

The settings for printer sharing are specified by performing the following steps:

Printer server (PC connected to a printer)

Upon completion of the setting, the shape of the icon changes indicating that the printer is shared.

NOTE 1. Refer to the manual for the network card and Windows users' guide for connections among
computers.

2. On Windows 98/Me, a computer connected to a printer must be set up to allow printer sharing
by performing the following operations:
1) Double-click on Network in control panel, and then click  button

in the Network Configuration tab.
2) Check [I want to be able to allow others to print to my printer(s).] in the File and Print

Sharing dialog box.

1 Install the printer driver on the computer to be connected
to the machine.

2 Click the Start button, select Settings, and then click
Printers.

3 Right-click on the desired printer icon and select
[Sharing...] in the popup menu.

4 Select Shared As in the properties dialog box.

5 Click the  button.OK

File and Print Sharing...
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Remote (PC that uses another computer's printer)

The operations above enables output from the remote computer to a printer connected to the printer server.

1 Click the Start button, select Settings, and then click
Printers.

2 Double-click Add Printer in the printers folder.
Add Printer Wizard appears.
Click the  button.

3 Select Network Printer.
Click the  button.

4 Specify the other computer's printer by entering the
network path.

Then, complete the installation following instructions of
the Add Printer Wizard.

Next

Next
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Additional Information about the Printing System

• About Plug and Play
This printer driver is not Plug and Play-compatible.

• About setting of functions
When the same function is allowed to be set by both the application and the printer driver, the priority of
setting may be on the application side in some cases, and on the printer driver side in other cases.

• About rasterizing process
As all rasterizing process is performed on the computer side, the printing time depends on the processing
capability of the computer.

• About Scaling
Scaling may not function correctly in some applications.  In this case, specify a zoom rate on the printer
driver to match the same size as the item being printed (100%).

• About printing through a network
When printing with the spooler setting set to [Print directly to the printer], stacked printing data in the
spooler may prevent printing.  In this case, restart Windows on the Server and Client PC.  Then, change
the spooler setting to other than [Print directly to the printer], and perform printing again.

•  About printing through LPT1 on Windows 98/Me
If an LPT1 write error occurs, please change the spooler setting to [Start printing after last page is
spooled].

• If there are other pending document files when deleting documents during printing, deleting only
documents during printing may disturb images of the pending files. 
In this case, delete the pending files as well.  Then, turn the machine Off and On, and re-print the file(s)
again.

• About energy saver mode
LPT1 write error occurs when the device is in the Energy Saver Mode (Sleep), Press the Energy Saver key
on the device to make it revert from the Energy Saver Mode (Sleep).

• When using N in 1, and there are different document sizes in a file, N in 1 combines the documents with
the same size and then prints accordingly (i.e.  You have 3 pages of Letter size documents and 2 pages of
Legal size documents.  The first 3 pages will be in "2 in 1" format and are printed in Letter size, then the
following 2 pages will be in "2 in 1" format and are printed in Legal size).

• If strange data was printed when the job was canceled, select the "Detail" tab in the properties of the
printer, click the "Spool Settings" button, check "Spool print jobs so program finishes printing faster", and
check "Start printing after last page is spooled". (Windows 98/Me only)

• Do not use “Separator page” under “General” on the Windows printer setting screen.

• For information on restrictions concerning the Adobe PS printer driver, refer to the ReadmeAdobe.wri file
displayed when the Adobe PS printer driver is installed.

• This printer driver’s help file is the standard help file for Adobe PostScript. For help on the printer
specifically, refer to these operating instructions.

• For information on other restrictions, refer to the “enreadme.wri” file in the operating instructions (CD-
ROM).

• To use Adobe PageMaker 6.5 with Windows, copy the PPD file on the CD to
c:\pm65\rsrc\UsEnglish\ppd4\.

1. Copy the printer’s PPD file to \pm65\rsrc\UsEnglish\ppd4\ on the hard disc on which Adobe 
PageMaker 6.5 is installed.

2. Select "Print" from the "File" menu.
3. Set both "Printer" and "PPD" to "Panasonic DP-6010PS".
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Restrictions

• About printing from WordPerfect 9
There is a case where the display of a print button becomes [FAX] in the printing of WordPerfect 9.  [FAX]
button is used for the normal printing.

• With some applications, such functions as Zoom, Nin1, Nup and Watermark may not work properly. If this
is the case, click the right mouse button on the desired printer driver at ??"Start" – "Settings" – "Printer",
select "Standard for document" or "Printer properties"?? and change the setting for the desired
function, then start up the application and print.
If the function still does not work, either use a different application or do not use that function. The function
may work properly with the latest version of that application.

• If the font is set to "Substitute with Device Font" or "Substitute printer fonts for True Type fonts when
applicable", the True Type fonts on the screen will be substituted with the printer’s fonts when printing, so
depending on the font the print may look different from the screen.  If so, set to "Download as Softfont" or
"Do not use printer fonts".

• The Punch function may not work properly, depending on the specified position or paper size. If this is the
case, change the paper size or specified position.  For paper sizes supported by the finisher, refer to the
finisher’s operating instructions.

• With Macintosh, even if the output is set to "Collation", this setting will not be reflected in the output.

• The output is the same as for "Landscape" even if "Rotated" is selected for "Orientation".

• When printing from Windows NT, "JOB OWNER" remains blank at "JOB QUEUE", "MAIL BOX" and
"SECURE MAIL BOX" on the printer.

• When printing from Windows 2000, "FILE NAME" and "JOB NAME" are set to "Panasonic DP" at "JOB
QUEUE", "MAIL BOX" and "SECURE MAIL BOX" on the printer.

• When printing in reduced scale using Microsoft Access, multiple pages may be printed on a single sheet.

• Printing in magnified scale is not possible with Adobe AcrobatReader 5.0.
95
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Troubleshooting

Troubleshooting

If the printing operation fails, check the following items first:

• The connection cable (Parallel Printer Cable or Ethernet LAN Cable) is properly connected.
• Power of the device is turned ON.
• Paper is loaded properly in the device.
• An error message is not displayed on the device.

The above points can be verified by printing a test page. Refer to the following for procedures on test page
printing:

Printing Operation Fails

Windows 98/Me [General Tab]  (See page 33)

Windows NT 4.0 [General Tab]  (See page 46)

Windows 2000/XP [General Tab]  (See page 53)
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Document is Not Printed Correctly

Problem Solution
Characters are not printed in the correct positions or the
characters near the edges of the page are missing.

• Check and specify the paper size and orientation
settings in the printer driver to coincide with the
application.

• The characters are outside the printing area of the
machine.

The font type is wrong. • Check if the selected font is installed on the PC.

Printing stops in the middle of the run. • Check if there is any problem on the network.

Although print data is transferred to the digital copier, it
does not print.

• Make sure the printer is on line.
97
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Printing Area

Top

0.1/2.5

0.1/2.5

0.1/2.50.1/2.5
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Font Table

No. Symbol Set
1 Albertus ‡

2 Albertus Italic ‡

3 Albertus Light ‡

4 AntiqueOlive Bold §

5 AntiqueOlive Compact §

6 AntiqueOlive Itallic §

7 AntiqueOlive Roman §

8 Apple Chancery ¤

9 Arial ‡

10 Arial Bold ‡

11 Arial Bold Italic ‡

12 Arial Italic ‡

13 ITC AvantGarde Gothic Book °

14 ITC AvantGarde Gothic Book Oblique °

15 ITC AvantGarde Gothic Demi °

16 ITC AvantGarde Demi Oblique °

17 Bodoni

18 Bodoni Bold

19 Bodoni Bold Italic

20 Bodoni Italic

21 Bodoni Poster

22 Bodoni Poster Compressed

23 ITC Bookman Demi °

24 ITC Bookman Demi Italic °

25 ITC Bookman Light °

26 ITC Bookman Light Italic °

27 Carta •

28 Chicago ¤

29 Clarendon †

30 Clarendon Bold †

31 Clarendon Light †

32 CooperBlack

33 CooperBlack Italic

34 Copperplate Gothic 33BC

35 Copperplate Gothic 32BC

36 Coronet ••

37 Courier

38 Courier Bold

39 Courier Bold Oblique

40 Courier Oblique
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Font Table
41 Eurostile **

42 Eurostile Bold **

43 Eurostile Bold Extended Two **

44 Eurostile Extended Two **

45 Geneva ¤

46 GillSans ‡

47 GillSans Bold ‡

48 GillSans Condensed Bold ‡

49 GillSans Bold Italic ‡

50 GillSans Condensed ‡

51 GillSans Extra Bold ‡

52 GillSans Italic ‡

53 GillSans Light ‡

54 GillSans Light Italic ‡

55 Goudy Oldstyle

56 Goudy Bold

57 Goudy Bold Italic

58 Goudy ExtraBold

59 Goudy Oldstyle Italic

60 Helvetica †

61 Helvetica Bold †

62 Helvetica Bold Oblique †

63 Helvetica Condensed †

64 Helvetica Condensed Bold †

65 Helvetica Condensed Bold Oblique †

66 Helvetica Condensed Oblique †

67 Helvetica Narrow †

68 Helvetica Narrow Bold †

69 Helvetica Narrow Bold Oblique †

70 Helvetica Narrow Oblique †

71 Helvetica Oblique †

72 HoeflerText Black ¤

73 HoeflerText Black Italic ¤

74 HoeflerText Italic ¤

75 HoeflerText Ornaments ¤

76 HoeflerText ¤

77 Joanna ‡

78 Joanna Bold ‡

79 Joanna Bold Italic ‡

80 Joanna Italic ‡

81 LetterGothic

No. Symbol Set
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82 LetterGothic Bold

83 LetterGothic Bold Slanted

84 LetterGothic Slanted

85 ITC Lubalin Graph Book °

86 ITC Lubalin Graph Book Oblique °

87 ITC Lubalin Graph Demi °

88 ITC Lubalin Graph Demi Oblique °

89 Marigold °

90 ITC Mona Lisa Recut °

91 Monaco ¤

92 New Century Schoolbook Bold †

93 New Century Schoolbook Bold Italic †

94 New Century Schoolbook Italic †

95 New Century Schoolbook Roman †

96 NewYork ¤

97 Optima †

98 Optima Bold †

99 Optima Bold Italic †

100 Optima Italic †

101 Oxford °

102 Palatino Bold †

103 Palatino Bold Italic †

104 Palatino Italic †

105 Palatino Roman †

106 Stempel Grarmond Bold †

107 Stempel Grarmond Bold Italic †

108 Stempel Grarmond Italic †

109 Stempel Grarmond Roman †

110 ITC Symbol °

111 Tekton •

112 Times Bold †

113 Times Bold Italic †

114 Times Italic †

115 Times Roman †

116 Times New Roman ‡

117 Times New Roman Bold ‡

118 Times New Roman Bold Italic ‡

119 Times New Roman Italic ‡

120 Univers †

121 Univers Bold †

122 Univers Bold Oblique †

No. Symbol Set
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Font Table
Adobe, PostScript, the Adobe logo and the PostScript logo are trademarks
of Adobe Systems Incorporated which may be registered in certain jurisdictions.

• registered trademark of Adobe Systems Incorporated
* trademark of AlphaOmega Typography

¤ trademark of Apple Computer, Inc.
•• registered trademark of Ludlow Type Foundry

ˇ registered trademark of International Typeface Corporation
† trademark of Linotype-Hell AG and/or its subsidianes

§ registered trademark of Marcel Olive
ˇ trademark of Microsoft Corporation

‡ trademark of The Monotype Corporation
** trademark of Nebiolo

123 Univers Oblique †

124 Univers Light †

125 Univers Light Oblique †

126 UniversCondensed †

127 UniversCondensed Bold †

128 UniversCondensed Bold Oblique †

129 UniversCondensed Oblique †

130 UniversExtended †

131 UniversExtended Bold †

132 UniversExtended Bold Oblique †

134 UniversExtended Oblique †

135 Wingdings ˇ
136 ITC ZapfChancery Mediumltalic °

137 ITC ZapfDingbats °

No. Symbol Set
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For Service, Call:

WARRANTY

U.S.A. Only

PANASONIC DOCUMENT IMAGING COMPANY MAKES NO WARRANTIES, GUARANTEES OR
REPRESENTATIONS, EXPRESSED OR IMPLIED, TO THE CUSTOMER WITH RESPECT TO THIS
PANASONIC MACHINE, INCLUDING BUT NOT LIMITED TO, ANY IMPLIED WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

PANASONIC DOCUMENT IMAGING COMPANY ASSUMES NO RISK AND SHALL NOT BE SUBJECT
TO LIABILITY FOR ANY DAMAGE, INCLUDING, BUT NOT LIMITED TO DIRECT, INDIRECT,
SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES OR LOSS OF PROFITS SUSTAINED BY
THE CUSTOMER IN CONNECTION WITH THE USE OR APPLICATION OF THIS PANASONIC
MACHINE. SEE YOUR DEALER FOR DETAILS OF DEALER’S WARRANTY.

Published in Japan
August 2002
DZSD001779-0
T0302-1032

Matsushita Electric Industrial Co., Ltd.
Website : http://www.panasonic.co.jp/global/

Panasonic Document Imaging Company
A Business Unit of Matsushita Electric Corporation of America 
Two Panasonic Way
Secaucus, New Jersey 07094

Panasonic Canada Inc.
5770 Ambler Drive
Mississauga, Ontario L4W 2T3
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